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Getting Started

This chapter introduces the Autodesk MapGuide® In this chapter
Provider for Oracle® Spatial. Provider for Oracle Spatial is B About this document
a Microsoft® OLE DB data provider that serves spatial and B Overview
B System requirements
. TIM . TM
attribute data from an Oracle8i = Spatial or Oracle9i W Before installing Provider for
Oracle Spatial
Spatial data source. The data that Provider for Oracle
B Installation tasks
Spatial serves to Autodesk MapGuide® follows the B Cancelling installation
B Removing the installation
OpenGIS Simple Features specification for a COM/OLE ving !
B Updating or repairing the
component. installation




About This Document

6

This document is written for system administrators who install Provider for
Oracle Spatial for Autodesk MapGuide and manage its operations. The docu-
ment provides details about the following topics:

m The features and software requirements of Provider for Oracle Spatial

m Installing and configuring Provider for Oracle Spatial configuration files

m The mapping of OpenGIS WKB (Well-Known Binary) geometry to
Autodesk MapGuide geometry, which accounts for the minor differences
in appearance of maps in the Oracle and MWEF file formats

m Information about feature table availability, coordinate systems, and error
messages

For information about how to use Provider for Oracle Spatial, choose
Help » Contents in Autodesk MapGuide Author, click the Index tab, and
look up “vector layers.”

Documentation Conventions and Assumptions

This document assumes that you know how to configure, manage, and use
Oracle8i Spatial or Oracle9i Spatial, and how to create maps using Autodesk
MapGuide® Author. It assumes that you have read the Autodesk MapGuide
User’s Guide and Autodesk MapGuide Help.

This document also assumes that you have already loaded your data into
Oracle8i Spatial or Oracle9i Spatial. You can use the conversion tool from
FME® (Feature Manipulation Engine) at http://www.safe.com to load your
data into the Oracle8i Spatial or Oracle9i Spatial formats.

Copying Text from This Document

You can copy text from this PDF file and paste it into another application.
For example, you may want to copy code samples for use in your own work.
To copy text from a PDF file

1 Click the Text Select tool on the Acrobat Reader toolbar.
2 Drag to select the text you want to copy.
3 Right-click and choose Copy from the shortcut menu.

The text is copied to the Clipboard.

Chapter |  Getting Started



Overview

Data Consumer

Data Providers

Data

The Provider for Oracle Spatial is a member of the family of OLE DB providers
to Autodesk MapGuide Server. With the introduction of the Provider for
Oracle Spatial, Autodesk MapGuide® Server can now serve spatial and
attribute data directly from Oracle8i Spatial and Oracle9i Spatial data sources
using an open industry standard interface. Early versions of Autodesk
MapGuide Server could serve spatial data from proprietary SDF data sources
only. Autodesk MapGuide Server acts as a data consumetr, and is able to access
data from SDF, Oracle8i Spatial, and other OLE DB data provider components
known as Spatial Data Providers (SDP), as shown in the following diagram of
OLE DB components.

Autodesk MapGuide Server

Autodesk MapGuide Autodesk MapGuide Autodesk MapGuide
Spatial Data Provider Spatial Data Provider Data Provider
for SDF for SHP for Oracle8i Spatial

Oracle9i
Spatial

The Provider for Oracle Spatial is a member of the family of OLE DB providers to Autodesk MapGuide.

OLE DB data providers, such as Provider for Oracle Spatial, implement a set
of core OLE DB interfaces for interoperation with other OLE DB data
providers, service components, and consumer applications. OLE DB data
consumers are software programs, such as Autodesk MapGuide Server, devel-
opment tools, personal productivity applications, database products, and
OLE DB service components that need to access many kinds of data.

The standardized data access architecture of Provider for Oracle Spatial gives
Autodesk MapGuide users the following flexibility:

m Access to spatial and attribute data from SDP and OLE DB data sources
m Ability to create themes based on any SDP or OLE DB attribute, such as an
SDF key, name, or URL

This release of Provider for Oracle Spatial does not support data updates.

Overview | 7



System Requirements

The following diagram shows the typical system configuration.

Web Browser

Autodesk MapGuide
Author

Autodesk MapGuide Viewer

Client

Server

Web Server

‘ Autodesk MapGuide Server ‘

OLE DB

Provider for Oracle Spatial ocl Oracle Client

Windows Server

Unix or Windows Server

Oracle8i Spatial
or
Oracle9i Spatial

The Provider for Oracle Spatial serves Oracle Spatial data through a Web server to authors and
viewers.

Supported Platforms

You can install Autodesk MapGuide Server and Provider for Oracle Spatial
and on Windows® 2000 Server SP1 or SP2 (SP2 recommended) or on
Windows NT 4.0 SP4-SP6a (SP6a recommended).

Required Software

The following software, not included with Provider for Oracle Spatial, must
be installed on the server before installing Provider for Oracle Spatial:

m MDAC/OLE DB 2.5 SP1 or later (Windows NT only)—Microsoft® Data
Access Components (MDAC) establish a connection to the OLE DB data
source, which is Oracle8i Spatial or Oracle9i Spatial. MDAC 2.5 SP1is a
component of the Windows 2000 operating system, and it is available as

8 | Chapter | Getting Started



a stand-alone distribution program for Windows NT 4.0 that you can
download from the Web. MDAC is also included on the Autodesk
MapGuide Release 6 CD.

Autodesk MapGuide Server Release 6 or later—Install and authorize
Autodesk MapGuide Server before installing Provider for Oracle Spatial.
Provider for Oracle Spatial does not function with versions earlier than
Autodesk MapGuide Server Release 6.

Web Server—Ensure that Microsoft® Internet Information Server (11S) 4.0
or later, or Netscape® Enterprise Server 3.6 or later, or iPlanet Web Server
Enterprise Edition 4.1 is installed and properly configured.

Oracle8i Spatial Release 8.1.7 or Oracle9i Spatial Server—Install
Oracle8i Spatial Server or Oracle9i Spatial Server on a computer in a net-
work that the Oracle client software can access. You install the Server
using the Oracle installer or the command line. For more informa-
tion,refer to the Oracle documentation.

Oracle8i Release 8.1.7 or later client—Install the Oracle8i or Oracle9i
client software on the same computer as Provider for Oracle Spatial for
Autodesk MapGuide.

Required Hardware

m Pentium, 128 MB of RAM (minimum)
m 25 MB free hard disk space (minimum) plus space for data

Before Installing Provider for Oracle Spatial

Before installing Provider for Oracle Spatial, perform the tasks described in
this section.

To prepare for installing Provider for Oracle Spatial

1

Uninstall any Beta versions of Autodesk MapGuide Server and Provider for
Oracle Spatial if you installed them.

Warning You cannot install Autodesk MapGuide Server and Provider for
Oracle Spatial over previously installed Beta versions of those products.

Install MDAC/OLE DB 2.5 SP1.

Before Installing Provider for Oracle Spatial | 9



Install Autodesk MapGuide Server Release 6 or later (refer to the Autodesk
MapGuide Server User’s Guide).

Note Do not attempt to use an evaluation version of Autodesk MapGuide
Server.

Register Autodesk MapGuide Server.

You cannot install Provider for Oracle Spatial unless you are running an
authorized version of Autodesk MapGuide Server Release 6 or later.

Install the Oracle8i or Oracle9i client. The minimum client installation,
Application User, is sufficient.
Using the Oracle Net8"" Configuration Assistant, configure the Oracle net-

work service name, and test the Oracle client connection to the Oracle
server.

Installation Tasks

10

Perform the tasks described in this section to install Provider for Oracle
Spatial.

Note To install Provider for Oracle Spatial, you must be logged on as Adminis-
trator or as a user who is a member of the Administrators group.

1

Inform Autodesk MapGuide users to discontinue use of the Autodesk
MapGuide Server Service until you complete the installation.

The setup program stops Autodesk MapGuide Server Service during instal-
lation and restarts it after completing installation.

Insert the Autodesk MapGuide Release 6 CD into the CD-ROM drive. An
installation dialog box showing the following options is displayed:

m Server Products

m Author Products

m Viewer Products

m Third-Party Products

Note If the installation dialog box is not displayed, double-click the setup.exe
file on the Autodesk MapGuide Release 6 CD.

Click Autodesk MapGuide Server Products.

4 Click Provider for Oracle Spatial.

Chapter |
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The Welcome screen is displayed.

f5 Autodesk MapGuide[R) Oracle Spatial extension R6 Setup

Welcome
‘welcome to the Autodesk MapGuide Oracle Spatial extension Setup wizard,

The Setup wizard will install Autodesk MapGuide Oracle Spatial extengion on pour
computer,

To continue, click Next.

Cancel |

5 Click Next, and follow on-screen instructions to install the Provider for
Oracle Spatial.

Cancelling Installation

To cancel the installation, click the Cancel button displayed by the Provider
for Oracle Spatial installation program. Do not cancel the installation using
the Windows NT Task Manager. Cancelling the installation using the Task
Manager leaves files on your hard disk and does not restore your computer
to its original state.

Removing the Installation

Use the Add/Remove button on the Add/Remove Programs control panel to
remove Provider for Oracle Spatial. You can also use the Autodesk MapGuide
Release 6 CD to remove the installation. Removing the installation includes
removing registry entries and shortcuts.

Note To remove the installation, you must be logged on as Administrator or as
a user who is a member of the Administrators group.

Cancelling Installation | 11



To remove the installation

1 Inform Autodesk MapGuide users to discontinue use of the Autodesk
MapGuide Server service until you complete the changes.

2 Double-click Add/Remove Programs in the Control Panel.

The options for updating, repairing, or removing the installation are
displayed.

Welcome
‘welcome to the Autodesk MapGuide Oracle Spatial extension Setup wizard,

An existing installation of Autodesk MapGuide Oracle Spatial extension has been
detected. You car:
& Update or repair files
Fieingtallz any files that have changed since you last installed this release of Autodesk
MapGuide Oracle Spatial extengion. Use thiz option if you have received an updated

Autodesk MapGuide Oracle Spatial extenzion or if any of your installed files have been
corupted.

" Remove Autodesk MapGuide Dracle Spatial extension

Femoves Autodesk MapGuide Oracle Spatial extension and itz supporting files and
registry entries.

To continue, click Next.

Cancel |

3 Click Remove Autodesk MapGuide Provider for Oracle Spatial.

4 Click Next, and then follow on-screen instructions to remove the Provider
for Oracle Spatial.

Updating or Repairing the Installation

When you update or repair the installation, the install program reinstalls all
of the Provider for Oracle Spatial files according to their configuration during
the initial installation. If an older or missing file is detected on the system,
the installation program reinstalls the files and overwrites shortcuts.

To update or repair the Provider for Oracle Spatial, you need to use the
Autodesk MapGuide Release 6 CD. Do not use the Add/Remove Programs
control panel. Follow these steps to upgrade or repair the installation.

Note To update or repair Provider for Oracle Spatial, you must be logged on as
Administrator or as a user who is a member of the Administrators group.

12 | Chapter | Getting Started



To update or repair the installation
1 Inform Autodesk MapGuide users to discontinue use of the Autodesk
MapGuide Server Service until you complete the changes.

2 Insert the Autodesk MapGuide Release 6 CD into the CD-ROM drive. An
installation dialog box should be displayed. If it is not, double-click the
setup.exe file on the Autodesk MapGuide Release 6 CD.

3 Click Autodesk MapGuide Server Products.
4 Click Provider for Oracle Spatial.

The options for updating, repairing, or removing the installation are
displayed.

f5 Autodesk MapGuide[R) Oracle Spatial extension R6 Setup

Welcome
‘welcome to the Autodesk MapGuide Oracle Spatial extension Setup wizard,

An existing installation of Autodesk MapGuide Oracle Spatial extension has been
detected. You car:
& Update or repair files
Fieingtallz any files that have changed since you last installed this release of Autodesk
MapGuide Oracle Spatial extengion. Use thiz option if you have received an updated

Autodesk MapGuide Oracle Spatial extenzion or if any of your installed files have been
corupted.

" Remove Autodesk MapGuide Dracle Spatial extension

Femoves Autodesk MapGuide Oracle Spatial extension and itz supporting files and
registry entries.

To continue, click Next.

Cancel |

5 Click Update Or Repair Files.

6 Click Next, and then follow on-screen instructions to update or repair the
Provider for Oracle Spatial files.

Updating or Repairing the Installation | 13
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Configuration
This chapter describes how to configure Autodesk In this chapter
MapGuide® Provider for Oracle® Spatial by creating a B Configuration tasks

data source, a Microsoft® Universal Data Link (UDL) file, Controlling error logging

B Supported database standard
which is used to establish an OLE DB connection from and schemas
Autodesk MapGuide® Server to Provider for Oracle

Spatial. You control error logging during creation of the

data source.
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Configuration Tasks

You configure the Provider for Oracle Spatial by performing the following
tasks:

m Gathering data source information—You need to obtain the name of
the Oracle server, user ID, password, and other information listed in the
“Data Source Information” table shown in “Gathering Data Source Infor-
mation.”

m Creating a data source—You store configuration information for the OLE
DB data source in the UDL file, which Autodesk MapGuide Server uses to
start Provider for Oracle Spatial. Use the Data Sources tab of the Properties
dialog box in Autodesk MapGuide® Server Admin to specify the name and
location of the file. Provider for Oracle Spatial loads data sources from the
specified location.

Gathering Data Source Information

Before creating the data source (UDL file), gather the information shown in
the following table:

Data Source Information

Name Property ID Description
Server DBPROP_INIT_DATASOURCE The name of the Oracle server as set up
Name in the Net8 client configuration for the
Oracle client.
Required.

Default Value: None.

User ID DBPROP_AUTH_USERID The user name for connecting to the
Oracle server that defines the default
schema of the connection.

Required.
Default Value: None.

16 | Chapter 2 Configuration



Data Source Information (continued)

Name Property ID

Description

Password DBPROP_AUTH_PASSWORD

The password to use when connecting
to the Oracle server.

Not required.

Default Value: None.

Log Level DBPROP_INIT_LOGLEVEL

The level of logging supported by the

provider, which is shown by one of the

following possible values:

0 - All logs reported

1 - Only error and warning logs
reported

2 - Only error logs reported

3 - No logs reported

Not required.

Default Value: 0

For more information, see “Controlling

Error Logging” on page 23.

Creating Data Sources

After installing Provider for Oracle Spatial, you create data sources. A data
source provides the following information for accessing data from an OLE DB

provider:

m The type of data that you want to access

m The server on which the data resides

m The database in which the data is stored

There are several ways to create a data source using the Data Link Properties

dialog box:

m Using Autodesk MapGuide Server Admin

m Using Windows NT® tools to create a UDL file for displaying the Data Link

Properties dialog box

m Using Windows 2000 tools to create a text file that contains the OLE DB
connection string for displaying the Data Link Properties dialog box

Configuration Tasks
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Using Autodesk MapGuide Server Admin

To create a data source file using Autodesk MapGuide Server Admin

| 1 In Autodesk MapGuide Server Admin, choose Edit » Properties, and click
the Data Sources tab in the Properties dialog box.

Properties [ %]

General Data Sources | Loggingl Users.-"GroupsI Hesourcesl Access Ke_l,lsl

Data sources:

| Available | Mew...
[v]

Eroperties... |
Eename... |
[elete |

|
S ample_\world_SDF
SDF

— Data zource search path:

[:\Program Files\Autodesk\MapGuideServersiData Sources

QK I Cancel | Lpply Help

2 Click New.
NowbataSowce |

Data source name:

[rata source type

& Microzoft Data Link (UDL] for OLE DB
' Autodesk Data Link [ADL) for DWG

[k | Cancel | Help |

3 Click Microsoft Data Link (UDL) For OLE DB if it is not selected.
4 Enter a data source name and click OK.

18 | Chapter 2 Configuration



The Data Link Properties dialog box is displayed.

Frawider | Eonnectionl Advancedl Al I

Select the data you want to connect to:

B3 Data Link Properties [ %]

| OLE DE Froviderfs)

1 [rata Provider for O
Autodesk Spatial Data Provider for SDF
CiDso

Microsoft Jet 3.51 OLE DB Provider

Microsaft Jet 4.0 OLE DB Provider

Microzoft OLE DB Provider for DTS Packages
Microzoft OLE DB Provider for Intemet Publishing
Microsoft OLE DB Provider for Microsoft Index Server
Microsoft OLE DB Provider for Microsoft Site Server Search
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for OLAP Services
Microsoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for SOL Server

Microzoft OLE DE Simple Provider

M5 Remate

MSDataShape

Met Library Collator

[

Mext »» |

o]

Cancel | Help

5 On the Provider tab, select Autodesk Spatial Data Provider For Oracle8i

from the list of data providers.
6 Click Next.

Configuration Tasks
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The Connection tab is displayed.

B3 Data Link Properties [ %]

Frovider - Cannection |Advanced| Al I

Specify the following to connect to Oracle data:

1. Enter a Server name:

2. Enter information to log on to the databaze:

Uszer name: I

Password: I

Test Connection |

QK I Cancel | Help |

7 On the Connection tab, enter the name of the Oracle server (Server Name)
and the Oracle user name (User ID) and password, and then click Test
Connection. For more information about these parameters, see the Data
Source Information table on page 16.

A message is displayed indicating the success or failure of making the
connection.

Autodesk(TM) Oracle 8i SDP Connectivity Test [E3

@ Connection Succeeded

In the event of a failure, check your user name and password and the con-
nection parameters.

20 | Chapter 2 Configuration



Configure error logging (see “Controlling Error Logging” on page 23).

When you finish setting error logging, click OK. Autodesk MapGuide
Server creates the data source in the first directory in the server's data
sources search path.

Close the Data Link Properties dialog box.

Autodesk MapGuide Server Admin displays the name of the new data
source on the Data Sources tab of the Properties dialog box.

Using Windows NT

To create the data source using Windows NT

1

Open the Windows Explorer and navigate to the directory location for the
data source, or right-click in the Desktop.

Choose File » New in the Windows Explorer, or choose New in the
Desktop.

Note If you installed MDAC 2.5, you must run the script provided by
Microsoft to restore the Microsoft Data Link submenu of the New menu.
Click Microsoft Data Link.

Perform steps 4-9 of “Using Autodesk MapGuide Server Admin” on page
18.

Using Windows 2000

To create the data source using Windows 2000

1
2

Open the Windows Explorer.

Select the folder in which you want to save the data source. Right-click in
the results pane, and choose New » Text Document.

Right-click the text file you created in step 2, and then choose Rename.
Enter the new file name using a .udl file extension. Press ENTER.

Ignore the warning, if it is displayed, that changing file extensions may
cause files to become unusable.
Select the data source (UDL) file.

Perform steps 4-9 of “Using Autodesk MapGuide Server Admin” on page
18.

Configuration Tasks | 21
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Troubleshooting Data Source Problems

After completing one of the procedures to create the data source, perform the
following steps to check the data source.

To check the data source

1 Choose Edit » Properties in Autodesk MapGuide Server Admin, and click
the Data Sources tab. Under Data Source Search Path, check that the data
source exists in the search path of the server.

If the data source does not exist, perform steps 2—-4 below.

2 Check that a directory for the data source exists and that you have write
permission to access it.

3 Check that the name of the data source file is unique and valid for your
operating system. Delete a data source file of the same name if it exists.

4 Check for sufficient disk space for saving the data source.

5 Verify that you installed the Oracle client software correctly by using SQL
Plus to connect to the Oracle database from the server where you installed
the Provider for Oracle Spatial.

Understanding the Data Source File Syntax

You need to understand data source file syntax if you want to edit UDL files
manually or programmatically. During creation of the data source, a connec-
tion string is written into the UDL file in flat text format. A connection string
is a string version of the initialization properties needed to connect to a data
store. The following example shows the minimal connection string:

[oledb]

; Everything after this line is an OLE DB initstring
Provider=ASDPOSP.08ISDP.1; Password=password;User ID=username;Data
Source=mg_01;Locale Identifier=0;Extended Properties="";Connect
Timeout=0;Log Level=2

Chapter 2 Configuration



Connection String Syntax

The connection string syntax must adhere to the formats described in this
section.
Connection String Format

The basic connection string format consists of a series of keyword and value
pairs separated by semicolons. The equals symbol (=) connects each keyword
andiisvahJe.Forexanqﬂe, keywordl=value; keyword2=value.

Provider Keyword Format

The Provider keyword identifies the OLE DB provider. The keyword is
followed by an equals symbol (=). For example, provider=.

The value of the provider may have a version number attached to the end of
it. The following example specifies version 1:

Provider=ASDPOSP.0O8ISDP.1

Controlling Error Logging

The operating system reports errors in the Event Viewer. Options on the
Advanced tab of the Data Link Properties dialog box set the level of error
logging provided by Provider for Oracle Spatial.

To set error logging
1 In Autodesk MapGuide Server Admin, choose Edit » Properties and click
the Data Sources tab in the Properties dialog box.

2 Select Autodesk Spatial Data Provider For Oracle from the list of data
sources.

3 Click Properties.
The Data Link Properties dialog box is displayed.

4 Click the Advanced tab.

Controlling Error Logging | 23



The Error Logging Level options are displayed.

Providerl Connection  Advanced |AII I

Error Logging Level
&l Logs Reported

& Ony Eror and W arning Logs Reported

" Only Eror Logs Reported

" Mo Logs Reported

QK I Cancel | Help |

5 Specify the error logging level by clicking one of the following options:
m All Logs Reported
m Only Error And Warning Logs Reported
m Only Error Logs Reported
m No Logs Reported

6 Click OK to close the Data Link Properties dialog box and click OK again
to close the Properties dialog box.

24 | Chapter 2 Configuration



Supported Database Standard and Schemas

The Provider for Oracle Spatial supports OLE DB, Microsoft’s component
database architecture. OLE DB is a Component Object Model (COM)
programming interface for accessing diverse information sources, regardless
of location or type. OLE DB is an open specification that includes Microsoft’s
Open Database Connectivity (ODBC) industry-standard data access inter-
face. ODBC accesses relational databases, but OLE DB works with relational
and nonrelational information sources.

Autodesk MapGuide Server accesses Oracle data provided by the Provider for
Oracle Spatial, using database schema information to determine its interac-
tion with Oracle. Using this schema information, Autodesk MapGuide
Viewer processes and displays the results of queries.

Supported Database Standard and Schemas | 25
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Geometry Mapping,
Coordinate Systems, and
Error Messages

This chapter describes the geometry mapping between In this chapter

the OLE DB components, how feature table availability is B Oracle Spatial to OpenGIS
WKB mapping

B OpenGlIS to Autodesk
MapGuide feature geometry

determined, and how the coordinate system of the data

within a feature table is established. Also included in this

mapping
chapter are error messages produced by Autodesk B Determining feature table
availability and the
MapGuide® Provider for Oracle® Spatial. coordinate system

B Using error messages
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Oracle8i Spatial and Oracle9i Spatial to
OpenGIS WKB Mapping

Understanding the mapping of the geometry types identified within
Oracle8i™ Spatial and Oracle9i"" Spatial to the types exported from Provider
for Oracle Spatial is important for using the products effectively. Oracle8i
Spatial and Oracle9i Spatial maintains a list of geometry types in a value list
called SDO_GTYPE and enumerate the values from 0 to 7. Provider for Oracle
Spatial uses these types and creates the WKB data array based on the
SDO_GTYPE to OpenGIS WKB mapping. The SDO_GTYPE has a value that is
expressed as dOOx, where d is a value of 1 through 4 and x is an integer. The
OpenGIS WKB Format column in the following table describes what the
Oracle data looks like after Provider for Oracle Spatial exports the data to
Autodesk MapGuide® Server:

Oracle Spatial-OpenGIS WKB Mapping

SDO_GTYPE Description OpenGIS WKB Format

UNKNOWN_ Oracle8i Spatial and NULL

GEOMETRY Oracle9i Spatial ignore this ~ Comment: The provider does not enumerate

Value: d000 GTYPE. this geometry element.

Single Point Geometry contains one Formats as a wkbPoint.

Value: d001 point only.
Comments: Examines the first triplet in
SDO_ELEM_INFO only. Ignores subsequent
triplets without an error or warning. All
geometry types other than point (ETYPE 1)
generate an error—a point cluster in the first
triplet (ETYPE 2) is treated as an error.

Single Linestring or Arc Geometry contains one Formats a single linestring (ETYPE 2) or single

String line string only. compound linestring (ETYPE 4) as a single

Value: d002 wkbLineString.

Comments: Examines only the first triplet or
set of triplets forming a compound linestring
in SDO_ELEM_INFO. Ignores subsequent
triplets without an error or warning. All
geometry types other than linestring (ETYPE
2) or

compound linestring (ETYPE 4) generate an
error if encountered in the first triplet or in
the first set of triplets identified for a com-
pound linestring.
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Oracle Spatial-OpenGIS WKB Mapping (continued)

SDO_GTYPE

Description

OpenGIS WKB Format

Single Polygon
Value: d003

Geometry contains one
polygon only. May contain
multiple holes.

Formats a single polygon (ETYPE 3) with only
one ring as a wkbPolygon. Formats a single
polygon with more then one ring as a
wkbMultiPolygon.

Comments: Geometry types other than poly-
gon (ETYPE 3) or compound polygon (ETYPE
5, which can contain ETYPE 2 elements)
generate an error.

Heterogeneous Collec-
tion
Value: d004

Geometry is a heteroge-
neous collection of other
geometries.

Comments: Compound linestrings (ETYPE 4)
must contain only linestring (ETYPE 2)
elements, or an error occurs. Collections
(SDO_GTYPE 4) can contain any type of
geometry in any order without restrictions.
Obijects created within a collection are for-
matted as specified elsewhere in this table for
each

individual geometry or homogenous geome-
try group. Errors occur if the collections are
related to an invalid database entry, such as a
NULL ordinate.

Point Collection
Value: d005

Multipoint. Geometry con-
tains one or more points.

Formats a single point (ETYPE 1) as a
wkbMultiPoint composed of a single
wkbPoint.

Formats a single point cluster (ETYPE 2) as a
wkbMultiPoint composed of multiple
wkbPoints.

Formats an arbitrary mixture of single point
(ETYPE 1) and point clusters (ETYPE 2) as a
single wkbMultiPoint composed of multiple
wkbPoints.

Formats a multipolygon (SDO_GTYPE 5) as a
wkbMultiPolygon.

Comments: Geometry types other then sin-
gle point (ETYPE 1) or point cluster (ETYPE 2)
generate an error.
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Oracle Spatial-OpenGIS WKB Mapping (continued)

SDO_GTYPE Description

OpenGIS WKB Format

Linestring or Arc String Multilinesegment. Geome-
Collection try contains one or more
Value: d006 line strings.

Formats a single linestring (ETYPE 2) or single
compound linestring (ETYPE 4) as a single
wkbMultiLineString composed of a single
wkbLineString.

Formats an arbitrary mixture of single
linestring (ETYPE 2) or compound linestring
(ETYPE 4) elements as a single
wkbMultiLineString composed of multiple
wkbLineString.

Comments: All geometry types other than
linestring (ETYPE 2) or compound linestring
(ETYPE 4) generate an error.

Polygon Collection Geometry contains one or
Value: d007 more polygons.

Formats mixed polygons (ETYPE 5) as one
polygon. Formats polygons with holes (more
then one ring) as a wkbMultipolygon
composed of wkbPolygons for each ring.

Comments: Autodesk MapGuide renders
polygons with holes correctly. Compound
polygons (ETYPE 5) must contain linestring
(ETYPE 2) elements, or an error occurs.

No verification of the orientation or nesting
of exterior or interior rings of polygons is
made.
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Handling ETYPES and GTYPES with More Than
Two Dimensions

ETYPES greater than 10, which denote interior/exterior rings, are ignored.
Geometry GTYPES with a dimension greater than 2 are downgraded to a two-
dimensional geometry object. Downgraded geometries handle ordinates in a
dimensional fashion; ordinals subsequent to the first two are ignored.

Tessellating Arcs and Circles

Oracle8i Spatial and Oracle9i Spatial specify three points on an arc or circle.
Provider for Oracle Spatial uses a formula to create the arc from the begin-
ning angle to the end angle, or to draw the circumference of the circle. Two
parameters determine how the Provider for Oracle Spatial writes the arc:

® Minimum segments per arc
m Radians per arc stroke

The default value for the minimum segments per arc is 20 and the default
value of the radians per arc stroke is an angle in radians, 0.0523599 (3
degrees). You can change the values of these parameters in the Registry.

By default, Provider for Oracle Spatial creates an arc using 3-degree line
segments. The minimum segments per arc value sets the minimum number
of line segments that Provider for Oracle Spatial uses to make the arc. This
minimum ensures good resolution for small arcs.

Provider for Oracle Spatial draws the first point after O at 3 degrees. If an arc
is composed of less than 20 points, the angle for calculating each point is
decreased until the arc is composed of a minimum of 20 points.
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OpenGIS WKB to Autodesk MapGuide
Feature Geometry Mapping

32

Autodesk MapGuide Server maps OpenGIS Well-Known Binary (WKB)

Geometry representations to Autodesk MapGuide® feature geometry in the
context of the map layer on which the features are displayed. The following
table describes the mapping of OpenGIS WKB geometry types by Autodesk

MapGuide layer type:

OpenGIS WKB-Autodesk MapGuide Feature Geometry Mapping

Autodesk OpenGIS WKB
MapGuide Geometry Type
Layer Type

Autodesk MapGuide Feature
Geometry

Text wkbPoint

Text feature

wkbGeometryCollection

First wkbPoint element mapped to text
feature, all other elements ignored

Point wkbPoint

Point feature

wkbGeometryCollection

First wkbPoint element mapped to point
feature, all other elements ignored

wkbMultiPoint

First point from wkbMultiPoint mapped
to point feature, all others ignored

Chapter 3

Polyline wkbLinestring

Polyline feature

wkbMultiLinestring8

Polypolyline feature

wkbGeometryCollection

First wkbLinestring or wkbMultiLinestring
element mapped to polyline or
polypolyline feature, all other elements
ignored
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OpenGIS WKB-Autodesk MapGuide Feature Geometry Mapping

Autodesk OpenGIS WKB Autodesk MapGuide Feature
MapGuide Geometry Type Geometry
Layer Type
Polygon wkbPolygon Polygon feature if there is only a single
ring, all others become polypolygon
features
wkbMultiPolygon Polypolygon feature
wkbGeometryCollection First wkbPolygon or wkbMultiPolygon

element mapped to polygon or
polypolygon feature, all other elements
ignored

Determining Feature Table Availability and
the Coordinate System

A feature table is an Oracle8i Spatial or Oracle9i Spatial table that has at least
one geometry column of type SDO_GEOMETRY.

The Provider for Oracle Spatial relies on the information contained in a view
called ALL_SDO_GEOM_METADATA to determine which tables are feature
tables with one or more geometry columns of type SDO_GEOMETRY. For
more information about feature tables, refer to the Oracle documentation.

Using the SRID Column to Determine the
Coordinate System

If the SRID column for a row in the ALL_SDO_GEOM_METADATA view is
NULL, Autodesk MapGuide always assumes that the data is in a latitude/
longitude (geographic) coordinate system, unless the Map Window in which
the data is displayed is in an arbitrary XY (local) coordinate system. If a local
coordinate system is used, the SRID element within the SDO_GEOMETRY
object of each geometry should also be NULL.
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If the SRID column for a row in the ALL_SDO_GEOM_METADATA view is set
to a value, then Autodesk MapGuide uses this value as a foreign key into the
Oracle coordinate system table called MDSYS.CS_SRS to determine the coor-
dinate system of the geometry. The MDSYS.CS_SRS table contains a list of
coordinate systems and their definitions, which are described using the
OpenGIS Well-Known Text (WKT) representation. Based on the information
contained within the WKTEXT column of MDSYS.CS_SRS, Autodesk
MapGuide automatically transforms the geometry from the storage coordi-
nate system used within Oracle8i Spatial and Oracle9i Spatial to that used by
the Map Window in which the data is being displayed.

Known Issue with Oracle WKT Representations

The OpenGIS WKT representation for coordinate systems is relatively new
and different vendors may use different WKT strings to represent the same
coordinate system. In some cases, Autodesk MapGuide may not recognize
the Oracle WKT representation of coordinate systems that come pre-installed
in MDSYS.CS_SRS. In this case, you can use the file CSMap_WKT.txt, which
contains a list of all coordinate systems and their associated WKT represen-
tation strings that are supported by Autodesk MapGuide and Provider for
Oracle Spatial. You can add the coordinate system definitions from this file
to the MDS.CS_SRS table to represent any coordinate system supported by
Autodesk MapGuide. As the OpenGIS WKT representation of coordinate
systems matures, differences will be minimized.
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Using Error Messages

Provider for Oracle Spatial reports errors in the Event Viewer. Error messages
include an error code, an error level indicator, and a text string describing the
error and the line number, file name, and module name where the error

occurred. Provider for Oracle Spatial generates the following error messages:

Provider for Oracle Spatial Error Messages

Error Code

Error Message

ERRORCODE_OCI_GENERICERROR

An indeterminate Oracle Call Interface ( OCI)
error occurred.

ERRORCODE_OCI_WITHTEXT

Oracle Call Interface (OCl): < Text message
identifying the OCl error - generated by
Oracle>

ERRORCODE_OCI_INVALIDHANDLE

Invalid OCI handle.

ERRORCODE_OCI_NOTINITIALIZED

An attempt was made to use the OCl library
without initialization.

ERRORCODE_OCI_INITIALIZED

An attempt was made to initialize an already
initialized OCl library.

ERRORCODE_OCI_SERVERNOTINITIALIZED

An attempt was made to use an OCl server
object without initialization.

ERRORCODE_OCI_SERVERNOTATTACHED

An attempt was made to use an OCl server
object without attaching to it.

ERRORCODE_OCI_SERVERALREADYATTACHED

An attempt was made to attach to an OCI
server object that was already attached to.

ERRORCODE_OCI_SESSIONNOTINITIALIZED

An attempt was made to use an OCI session
object without initialization.

ERRORCODE_OCI_SESSIONALREADYSTARTED

An attempt was made to start an OCI session
that was already started.

ERRORCODE_OCI_SESSIONNOTSTARTED

An attempt was made to use an OCl session
object that was not started.
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Provider for Oracle Spatial Error Messages (continued)

Error Code Error Message

ERRORCODE_OCI_SERVERCONTEXTNOTINITIALIZE An attempt was made to use an OCl server
D context without initialization.

ERRORCODE_OCI_STATEMENTNOTINITIALIZED An attempt was made to use an OCI statement
object without initialization.

ERRORCODE_OCI_NULLOBJECT A geometry object definition contained an
invalid data (OCI) and was set to NULL (empty
object).

ERRORCODE_OCI_ELEMENT_DOESNT_EXIST An attempt was made to access an element
outside the valid bounds of an OCI Array or
Collection.

ERRORCODE_OCI_BAD_ARRAY_VALUE An OCI Array or Collection contained an invalid
value.

ERRORCODE_SUCCESSWITHINFO The OCI call succeeded and returned extended
information.

ERRORCODE_STLEXCEPTION An STL Exception was thrown.

ERRORCODE_BUFFERTOOSMALL A preallocated buffer was too small to handle

the source data.

ERRORCODE_OUTOFMEMORY Memory allocation failure.

ERRORCODE_NULLSTATEMENTOBJECT The OCI Statement object is null.

ERRORCODE_DS_GENERICERROR An indeterminate data source error has
occurred.

ERRORCODE_DS_NOTINITIALIZED An attempt was made to use the data source

object prior to its initialization.

ERRORCODE_DS_ALREADYINITIALIZED An attempt was made to initialize an already
initialized data source object.

ERRORCODE_DS_NOSERVERNAME An attempt was made to initialize a data source
object without providing a target server name.
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Provider for Oracle Spatial Error Messages (continued)

Error Code

Error Message

ERRORCODE_DS_CANTCREATESESSION

Failed to create session object.

ERRORCODE_DS_REQ_INIT_PROPERTIES_NOT_
AVAILABLE

Required initialization properties are not avail-
able in the UDL string.

ERRORCODE_SESS_OPENSESSIONS

All active sessions must be closed before
uninitializing the provider.

ERRORCODE_SESS_ALREADYINITIALIZED

An attempt was made to initialize an already
initialized session object.

ERRORCODE_RS_NOSESSIONOBJECT

The provider could not retrieve the rowset
object's session.

ERRORCODE_RS_NOSTATEMENTOBJECT

Failed to create an Oracle statement object
within the rowset object.

ERRORCODE_RS_NOSTATEMENTTORESET

An attempt to reset the execution of a SQL
statement has failed.

ERRORCODE_RS_INVALID_SQBOX_DATATYPE

The SPATIAL_FILTER bind parameter has an
invalid datatype. The filter must be either an
IStream* or a SafeArray.

ERRORCODE_RS_INVALID_SQBOX_FEATURE

The SPATIAL_FILTER bind parameter must be a
WHKB represented polygon.

ERRORCODE_RS_INVALID_SPATIAL_OPERATOR

The SPATIAL_FILTER operator must be of type
DBPROP_OGIS_INTERSECTS for this provider.

ERRORCODE_COULD_NOT_RETRIEVE_METADATA _
INFO

Sufficient information could not be retrieved
from the underlying datasource to properly
compose the requested metadata table.

ERRORCODE_CD_NOSESSIONOBJECT

The provider could not retrieve the command
object's session.

ERRORCODE_CD_NOSTATEMENTOBJECT

Failed to create an Oracle statement object
within the command object.
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Provider for Oracle Spatial Error Messages (continued)

Error Code

Error Message

ERRORCODE_COLINFOTARGET_NOTEMPTY

An attempt was made to create column
information in an object with column info
already present.

ERRORCODE_COLINFOSOURCE_EMPTY

An attempt was made to copy column
information from an empty dataset.

ERRORCODE_NOCOLUMNOBJECT

An attempt was made to bind a column with-
out having a column object.

ERRORCODE_NOFETCHEDDATAAVAILABLE

No prefetched data was available to fulfill the
get data request.

ERRORCODE_NOSOURCEDATA

An attempt was made to copy fetched data
from an invalid internal datasource.

WARNINGCODE_SOME_COLS_UNDEFINED

Some column types could not be defined
within the data provider.

WARNINGCODE_BAD_GEOMETRY_OBJECT

A geometry object contained invalid data such
as an invalid GTYPE value or a NULL ordinate or
info element.

ERRORCODE_BAD_GTYPE_VALUE

A geometry object contained an invalid GTYPE
value.

ERRORCODE_GEOM_ELEMENT_DOESNT_EXIST

An sdo_elem_info triplet for a geometry was
expected but was not found.

ERRORCODE_GEOM_BAD_OFFSET

An sdo_elem_info triplet for a geometry
contained a bad OFFSET value.

ERRORCODE_GEOM_BAD_ETYPE

An sdo_elem_info triplet for a geometry
contained a bad ETYPE value.

ERRORCODE_GEOM_BAD_INTERPRETATION

An sdo_elem_info triplet for a geometry
contained a bad INTERPRETATION value.

ERRORCODE_GEOM_BAD_POINT_GTYPE
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A geometry of GTYPE Point contained invalid
point data.
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Provider for Oracle Spatial Error Messages (continued)

Error Code

Error Message

ERRORCODE_GEOM_BAD_POINT_DATA

A geometry of GTYPE MultiPoint or Point
contained invalid data.

ERRORCODE_GEOM_BAD_MIXEDSTRING_SUB_
GTYPE

A geometry of GTYPE MultiLinestring contained
a sub ETYPE that is not a linestring.

ERRORCODE_GEOM_BAD_LINESTRING_ETYPE

A geometry of GTYPE MultiLinestring or
Linestring contained an invalid linestring ETYPE.

ERRORCODE_GEOM_BAD_LINESTRING_DATA

A geometry of GTYPE MultiLinestring or
Linestring contained invalid data.

ERRORCODE_GEOM_BAD_ORDINATE

A geometry object definition contained invalid
ordinate data.

ERRORCODE_GEOM_TOO_FEW_CURVE_POINTS

A linestring geometry object definition con-
tained too few points to fully define a curve.

ERRORCODE_GEOM_BAD_POLYGON_SUB_GTYPE

A mixed polygon geometry object definition
contained an invalid sub ETYPE. Only linestring
subtypes are valid.

ERRORCODE_GEOM_BAD_POLYGON_ETYPE

A geometry of GTYPE Multipolygon or Polygon
contained an invalid geometry ETYPE.

ERRORCODE_GEOM_BAD_POLYGON_DATA

A geometry of GTYPE Multipolygon or Polygon
contained invalid data.

ERRORCODE_GEOM_TOO_FEW_POLYGON_POINTS

A polygon geometry object definition con-
tained too few points to fully define the

polygon.

ERRORCODE_GEOM_BAD_POLYGON_INTERPRETAT
ION

A polygon geometry object definition con-
tained an invalid interpretation value.

WARNINGCODE_GEOM_POLYGON_NOT_CLOSED

A polygon geometry object definition did not
form a closed object.

ERRORCODE_GEOM_POINTS_ARE_COLINEAR

An arc or circle definition contains three points
that are colinear.

ERRORCODE_GEOM_CREATEBYTEARRAY_FAILED

A geometry data fetch via a byte array failed.
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Provider for Oracle Spatial Error Messages (continued)

Error Code Error Message

ERRORCODE_GEOM_GETBUFFERFAILED A geometry data fetch into a data buffer failed.

ERRORCODE_PARAMETER_FETCH_FAILED An error occurred while fetching parameters for
the O8i SDP.

ERRORCODE_DLG_COULD_NOT_SET_RESOURCE A resource on a custom property page could
not be set with data from a UDL file.

ERRORCODE_DLG_COULD_NOT_GET_RESOURCE Data could not be retrieved from a field on a
custom property page.

ERRORCODE_INVALID_LICENSE Authentication of the Autodesk Spatial Data
Provider for Oracle8i has failed (rc=IL).

ERRORCODE_KEYOPEN_FAILED Authentication of the Autodesk Spatial Data
Provider for Oracle8i has failed (rc=KF).

ERRORCODE_ALPHA_EXPIRED Authentication of the Autodesk Spatial Data
Provider for Oracle8i has failed (rc=AE).

ERRORCODE_BETA_EXPIRED Authentication of the Autodesk Spatial Data
Provider for Oracle8i has failed (rc=BE).
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